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1. Introduction 

 
he Virtua Archives Management System gives you the ability to catalog not 
only individual items such as manuscripts, books, periodicals, pictures, and 
maps, but also whole archives in a way that makes clear the relationship 

between the items. The Archives Management System lets you do this via a 
hierarchical “tree” structure of linked MARC bibliographic records. The tree, which 
your catalogers create, graphically displays the relationships among all description 
records in an archive, where material needs to be presented not only in terms of its 
content, but also in terms of its context. The archival functionality described in this 
guide is in accordance with the ISAD(G): General International Standard Archival 
Description. 
 

Note: The Archives Management System is an add-on Virtua feature that must be 
purchased separately from the standard Virtua ILS. All functions that Virtua offers vis-
à-vis “normal” bibliographic records such as searching, creating duplicates (i.e., close 
copies), editing, and deleting also apply to archival bibliographic records. 

 

1.1 Archival Cataloging: An Overview 

 
Archival cataloging differs from bibliographic cataloging in that archival cataloging 
must take into account the many ways the hundreds, or even thousands, of items in an 
archive relate to one another and to the body that created them. In archival cataloging, 
the arrangement and ordering of the items is as important as the descriptions of the 
items. In other words, to understand an archive fully, you must be able to understand 
its context as well as its content. 
 
Virtua’s Archive Management System supports the following principles of archival 
cataloging: 
 

 Archives with different provenances should not be mixed or listed together. 

 When an archive is arranged, the original order of the archive must be retained. 

 Multilevel descriptions play an essential role in the arrangement of archival 
material. 

 
The ISAD(G) recognizes various levels of archival material, which we describe below. 
Virtua’s implementation supports these levels and can accommodate any number of 
additional levels:  
 

T 
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 Group, or Fonds - Largest body of material established based on provenance. The 
records of each distinct organization, body, or individual form a separate group. 

 Sub-group, or Sub-fonds - Division within a group. For example, in a company, 
the records of each department would form a separate sub-group.  

 Sub-sub-group, or Sub-sub-fonds - Division within a division.  

 Series - Assemblies of material that have a common physical character and that 
were created and used as a unit. Based on the principle of original order, these 
assemblies would be those that were maintained when the records were actively 
used by their creator(s).  

 Sub-series - Assemblies within a series.  

 File - Basic, physical unit used in the handling, storage, and retrieval of archival 
material (e.g., box, folder, volume, or bundle).  

 Item - Indivisible, individual component within a file. This level is usually confined 
to particularly valuable components.  

 
The relationships between the different levels of archival material form the basis of the 
hierarchical tree structure, which in turn graphically represents the order and 
arrangement of the archive. Depending on the nature of an archive, the tree might 
reflect the original order or impose a sensible order where none existed. 
 
In Virtua, different subfield codes in a locally-defined tag called the 999 ANCESTRY 
tag in the MARC record are used to designate different levels of archival material. For 
example, subfield $k specifies a Fonds level, and subfield $q specifies a File. In this 
way, by viewing the 999 ANCESTRY tag of any given record, you can determine the 
level of that record in the archival hierarchy. 
 

1.2 Using this Guide 

 
This guide is aimed at library catalogers, who, after reading the guide, will be able to… 
 

 Create archival description records on different levels. 

 Link description records into an archival tree structure. 

 Manipulate the archival tree by rearranging, adding, and deleting records. 
 
Before you use this guide to create parent records and the child records linked to them, 
it is important that you have a planned hierarchical structure. Virtua is flexible and lets 
you create large extended families, but be aware that the software recognizes the 
following relationships only: 
 

 Parent and child, e.g. a Fonds and a File attached directly to it. 

 Siblings, i.e., records that share a common parent, such as Files within a Series. 



Archives Management (v. 16.1)  3 
 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC.  

 
Although Virtua allows parents and children to have their own parents and children, 
Virtua does not recognize the relationship between grandparents and grandchildren or 
between cousins. The archival hierarchies are essentially a chain of parent-child 
relationships. We recommend that you plan accordingly and not just build the 
structure as you go along. 
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2. Creating Archival Records 

 
he first step in cataloging an archive is to create the Fonds record. The Fonds 
represents the top level of an archival structure. As defined in the General 
International Standard Archival Description, Second Edition, the Fonds “is 

the whole of the records, regardless of form or medium, organically created and/or 
accumulated and used by a particular person, family, or corporate body in the course 
of that creator’s activities and functions.”  
 
The diagram below shows a model of the level of arrangement of a Fonds as published 
in the second edition of the ISAD(G).  
 

 

T 
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2.1 Creating a New Fonds Record 

 
To create a new Fonds record, 
 
1. On the Virtua menu bar, click File, choose Records, and then choose Create 

Record.  
 
-OR- 

On the Cataloging toolbar, click New Record . 
 

 If you selected, on the Cataloging Options window, a workform to be the 
default workform, that workform will open automatically in the MARC Editor 
(Figure 2-2). Skip to step 5. 

 

 If you did not select a workform to be the default, the Create Record dialog 
box will appear (Figure 2-1). Go to step 2. 

 

Note: You can also choose the Create Other Record option from the Records 
sub-menu of the File menu. This option either opens the Create Record dialog box 
or automatically opens the Default Other Workform, if one is specified on the 
Cataloging Options window. 

 
 

 

Figure 2-1. Create Record Dialog Box - Choosing a Workform 
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2. Navigate to the directory that contains the workform you want to use to create a 
Fonds record.  

Note: By default, the Catalog directory of your Virtua installation contains the 
workforms that are shipped with your software. Virtua does not ship any 
workforms specific to archival cataloging, but you can customize any workform to 
be archive-specific. In the Catalog directory, you might want to create a folder of 
archive-specific workforms that you have customized. 

 
3. Select a workform from the list of files.  
 
4. Click the Open button. 
 

The MARC Editor appears, displaying the workform you chose. A sample Fonds 
workform is shown in Figure 2-2. 
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Figure 2-2. MARC Editor - Sample Fonds Record Workform 

 
5. Complete the workform (for details on using the MARC Editor, see the Virtua 

Cataloging User’s Guide). In Figure 2-2, notice the 351 tag subfield $c, which 
indicates the level at which this record is being created. 
 

Note: When creating a Fonds record, the 351 tag subfield $c should contain the 
text “Fonds,” as displayed in Figure 2-2. This enables Virtua to find only Fonds 
records when the Fonds Filter check box is checked in the Virtua client Search 
window. 

 
6. Save the record to the database. To do this,  
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 Click the File menu and then choose Save To Database. 
-OR- 

 On the Cataloging toolbar, click Save to Database . 
 

The record is saved immediately to the database. The View Bibliographic Record 
window appears, displaying the record you just created. 
 

7. Click the MARC tab, which shows the system-assigned Bib-ID of the Fonds in the 
001 tag (Figure 2-3). 

 
 

 

Figure 2-3. View Bibliographic Record Window - New Fonds Level Record 

 

Hint: Keep a note of the Bib-ID. Knowing the Bib-ID can save time when searching 
for the Fonds. The most direct way to access a bibliographic record is to do a control 
number search using the Bib-ID. 
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2.2 Creating a Child Record Below the 

Fonds Level 

 
Below the Fonds level, you can create any number of child records at various 
descriptive levels such as Sub-fonds, Series, or File. When you create a child record 
and attach it directly to the Fonds, Virtua will link the parent and child via the 004 tag; 
i.e., Virtua will insert the Bib-ID of the parent Fonds into the 004 tag of the child 
record. 
 
To create a child record attached directly to a Fonds, 
 
1. Search for and display the Fonds record in the View Bibliographic Record window 

(Figure 2-4). 
 

 

 

Figure 2-4. View Bibliographic Record Window 

 
In Figure 2-4, note the Bib-ID in the 001 tag on the MARC tab. Virtua uses the Bib-
ID to link to the child record. 
 
2. Right click and choose Create Child Record (Figure 2-5). 

-OR- 
Click the View Record pull-down menu and choose Create Child Record. 
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Figure 2-5. Create Child Record Menu Option 

 

 If you specified, on the Cataloging Options window, a workform to be the Default 
Child Workform, that workform will open automatically in the MARC Editor. Skip 
to step 5. 

 If you did not specify a workform as the Default Child Workform, the Create 
Record dialog box will appear (Figure 2-6). Go to step 3. 
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Figure 2-6. Create Record Dialog Box - Choosing a Workform 

 
3. In the Create Record dialog box, select the workform that is appropriate to the 

level of your material. 
 
4. Click the Open button. The workform opens in the MARC Editor where you can 

create the child record (Figure 2-7). 
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Figure 2-7. MARC Editor - Sub-fonds Record Workform 

 
Figure 2-7 shows that Virtua automatically copied the value of the 001 tag of the 
parent Fonds into the 004 tag of the child record. Virtua also added a second 
element in the 004 tag— a number 1, which indicates that this record is the first 
child record linked to this parent.  

 
5. Complete the workform, which may include adding a third element to the 004 tag. 

The third element is a number that indicates the number of gaps between (not 
including) the child and its parent. Normally, Virtua calculates this number 
automatically, but if it does not, you will need to add it. For information about 
gaps, see the section “Working with Gaps in the Archival Tree” in this guide. 
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6. Save the record to the database. To do this,  

 Click the File menu and then choose Save To Database. 
-OR- 

 On the Cataloging toolbar, click Save to Database .  
 
The record is saved immediately to the database. The View Bibliographic Record 
window refreshes, displaying the child record one level below its parent in the archival 
tree (Figure 2-8). 
 
 

 

Figure 2-8. View Bibliographic Record Window - New Sub-fonds Level 

 

2.3 Creating Additional Child Records 

 
The Create Child Record function lets you create a child record linked to any selected 
parent record. In the steps below, we will link an additional child record to the Fonds 
we created earlier. 
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To create an additional child record, 
 
1. Display the Fonds record in the archival tree and highlight it (Figure 2-9). 
 
 

 

Figure 2-9. View Bibliographic Record Window 

 
2. Right click and choose Create Child Record. 

-OR- 
Click the View Record pull-down menu and choose Create Child Record. 

 

 If you specified, on the Cataloging Options window, a workform to be the 
Default Child Workform, that workform will open automatically in the MARC 
Editor. Skip to step 5. 

 

 If you did not specify a workform as the Default Child Workform, the Create 
Record dialog box will appear (Figure 2-10). Go to step 3. 
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Figure 2-10. Create Record Dialog Box - Choosing a Workform 

 
3. Select the workform that is appropriate to the level of your material. 
 
4. Click the Open button.  

 
The workform opens in the MARC Editor, where you can create the child record 
(Figure 2-11). 
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Figure 2-11. MARC Editor - Sub-fonds Record Workform 

 
Figure 2-11 shows that Virtua automatically copied the value of the 001 tag of the 
parent Fonds into the 004 tag of the child record. Virtua also added a second 
element in the 004 tag— a number 2, which indicates that this record is the second 
child record linked to this parent. 

 
5. Complete the workform, which may include adding a third element to the 004 tag. 

The third element is a number that indicates the number of gaps between (not 
including) the child and its parent. Normally, Virtua calculates this number 
automatically, but if it does not, you will need to add it. 
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6. Save the record to the database. To do this,  

 Click the File menu and then choose Save To Database. 
-OR- 

 On the Cataloging toolbar, click Save to Database . 
 
The record is saved immediately to the database. The View Bibliographic Record 
window refreshes, displaying the second child record one level below the parent Fonds 
in the archival tree (Figure 2-12). 
 
 

 

Figure 2-12. View Bibliographic Record Window 

 

2.4 Creating Child Records on the 

Same Level (Sibling Records) 

 
To create a child record that is on the same level as other child records in the archival 
tree, you need to use the Insert Child Record function. The Insert Child Record option 
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lets you create a sibling record, and Virtua enables this option on the menus only when 
a child record has been selected in the archival tree.  
 
To insert a child (sibling) record,  
 
1. Display the desired archival tree, and select the record to which you wish to add a 

sibling (Figure 2-13). The new record that you insert will appear above the selected 
record, which in our example is The Aquarius Scripts. 

 
 

 

Figure 2-13. View Bibliographic Record Window 

 
2. Right click and choose Insert Child Record (Figure 2-14). 

-OR- 
Click the View Record pull-down menu and choose Insert Child Record. 
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Figure 2-14. Insert Child Record Menu Option 

 
The Create Record dialog box appears (Figure 2-15).  

 
 

 

Figure 2-15. Create Record Dialog Box - Choosing a Workform 
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3. Select the workform that is appropriate to the level of your material. 
 

4. Click the Open button. 
 

The selected workform opens in the MARC Editor (Figure 2-16). 
 
 

 

Figure 2-16. MARC Editor - Sub-fonds Record Workform 

 
Notice in Figure 2-16 that Virtua automatically copied the Bib-ID of the parent 
Fonds record into the 004 tag of this new child record even though you are 
inserting it as a sibling. The 2 at the end of the 004 tag indicates that this record 
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will be ranked as the second child. Virtua moves what is currently the second child, 
The Aquarius Scripts, into third place in the archival tree. 
 

5. Complete the workform, which may include adding a third element to the 004 tag. 
The third element is a number that indicates the number of gaps between (not 
including) the child and its parent. Normally, Virtua calculates this number 
automatically, but if it does not, you will need to add it. 

 
6. Save the record to the database. To do this,  

 Click the File menu and then choose Save To Database. 
-OR- 

 On the Cataloging toolbar, click Save to Database . 
 
The record is saved immediately to the database. The View Bibliographic Record 
window refreshes, displaying the newly inserted child record, The Midlothian Scripts, 
above the record you selected in the archival tree (Figure 2-17). 
 
 

 

Figure 2-17. View Bibliographic Window - Newly Inserted Child Record 
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2.4.1 Inserting a Child Record that Already Exists in the 
Database 

 
So far, we have been creating original archival records, but you can also insert into an 
archival tree a child record that already exists in the database. To do this, open the 
potential child record in the MARC Editor and manually edit the 004 tag to include the 
Bib-ID of the parent record to which you want to link your existing record. 
 
When you save the record to the database, Virtua automatically creates the 999 
ANCESTRY tag, which will contain the proper linkages.  
 

2.5 Searching for Fonds Records 

 
To perform a search for Fonds-level records, you can search for either the Bib-ID of 
the specific record you’re seeking, as described in the section, “Creating a New Fonds 
Record,” or you can select the Fonds Filter check box, shown in Figure 2-18. 
 
 

 

Figure 2-18. Virtua Search Window with Fonds Filter Check Box Selected 

 
When the Fonds Filter check box is selected, any search you perform will only show 
those results that have the text “Fonds” in the 351 tag subfield $c. When this check 
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box is selected, Virtua will display a confirmation message when you perform a search 
(Figure 2-19). 
 
 

 

Figure 2-19. Fonds Filter Confirmation Message 

 
To perform a search for a specific Bib-ID, use the Control Number search (Figure 
2-20). 
 
 

 

Figure 2-20. Performing a Bib-ID Control Number Search 
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3. Working with Gaps in the Archival 

Tree 

 
hierarchical tree of records often displays a description record attached to a 
parent record that is not on the level immediately above it. In between the 
parent and the child is a level that is empty, or unused, but still needs to be 

represented in the tree to maintain the appropriate associations. The unused level is a 
gap. The Virtua client represents a gap as a blank space at one of the levels of the tree.  

3.1 Introduction 

 
Virtua supports the creation and deletion of child-level gaps via the Add Child Level 
and Remove Child Level functions. When you add a gap between a child and its 
parent, the child moves down a level, and Virtua automatically inserts a 1 as the third 
element in the 004 tag of the child record to indicate that one gap exists between the 
parent and child. 
 
Adding a gap, or unused child level, and moving a record down a level are different 
ways of describing the Add Child Level function. Similarly, removing a gap, or unused 
child level, and moving a record up a level are different ways of describing the Remove 
Child Level function. 
 

Hint: Generally, we recommend that you use the Add a Child Level and Remove a 
Child Level functions only when it involves a single record—one with no children—
that is on the wrong level. 

 

3.2 Adding a Gap 

 
When you add a gap in a tree, you effectively move the record selected in the tree down 
a level. 
 
To add a gap, 
 
1. Display the archival tree in the View Bibliographic Record window. 
 

A 
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2. Highlight the record directly above which you want to add a gap (Figure 3-1), 
effectively moving the selected record down a level.  

 
 

 

Figure 3-1. View Bibliographic Record Window 

 
Figure 3-1 shows the File Example as the first child of the parent Series Example. 
We want to interpose an unused Sub-series level between the child and the parent. 

 
3. Right click and choose Add Child Level (Figure 3-2). 

-OR- 
Click the View Record pull-down menu, and choose Add Child Level. 
 
 



26 Archives Management (v. 16.1) 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 
 

 

Figure 3-2. Add Child Level Menu Option 

 
The View Bibliographic Record window refreshes, showing that a gap has been 
added at the Sub-series level and the selected record has moved down one level. 
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Figure 3-3. View Bibliographic Record Window - Gap Level Added 

 
The File Example record in Figure 3-3 is still linked to its parent Series Example, but 
we have now created an unused Sub-series level between the child and its parent. This 
gap is specified in the 004 tag’s third element, which in our example is the number 1, 
indicating that one gap exists between the child and its parent. 
 

3.3 Removing a Gap 

 
Just as you can add gaps, you can also remove them. When a single gap is interposed 
between a parent and a single child record, you can remove the gap and move the child 
up one level. 
  
To remove a gap, 
 
1. Display the archival tree in the View Bibliographic Record window. 

 
2. Highlight the record that you want to move up one level, effectively removing the 

gap above it (Figure 3-4). 
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Figure 3-4. View Bibliographic Record Window 

 
3. Right click and choose Remove Child Level (Figure 3-5).  

-OR- 
Click the View Record pull-down menu, and choose Remove Child Level. 
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Figure 3-5. Remove Child Level Menu Option 

 
The View Bibliographic Record window refreshes, showing that the gap has been 
removed and the selected record has moved up one level (Figure 3-6). 
 



30 Archives Management (v. 16.1) 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC. 
 

 

Figure 3-6. View Bibliographic Record Window - Gap Level Removed 

 
As you can see in Figure 3-6, since we removed the gap, the third element in the 004 
tag no longer exists. 
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4. Manipulating Records in the 

Archival Tree 

 
rchival functionality provides a number of options for manipulating records 
in the archival tree. We have already discussed moving records up a level and 
down a level via the Remove Child Level and Add Child Level functions. 

Virtua also offers an option to change the order of records that are on the same level. 
In addition, there are options for expanding, collapsing, and printing the tree. You can 
also manually relink records in the tree. For easy reference to the hierarchical structure, 
Virtua automatically generates a non-editable tag, 999 ANCESTRY tag, which stores 
information about all the linkages and gaps in the tree. 
 

4.1 Reordering Sibling Records in a 

Tree 

 
After creating/inserting child records, you may wish to put them in an order different 
from the one determined by default. Virtua’s default ordering method is as follows:  
 

 If you use the Create Child Record function to add child records, they are 
displayed in the archival tree in the order in which they were added. 

 

 If you use the Insert Child Record function to add a child record, it is displayed in 
the archival tree above the record you selected when you began the insert child 
record process. 

 
To change the order of sibling records, 
 
1. On the View Bibliographic Record window, expand the archival tree.  
 
2. In the desired branch, highlight the child record you wish to move (Figure 4-1). 

 

A 
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Figure 4-1. View Bibliographic Record Window 

 
3. Click the right mouse button, and choose Change Order. 
 
The Change Sort Order window appears (Figure 4-2), displaying the list of records 
within the same branch as the record you highlighted. 
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Figure 4-2. Change Sort Order Window 

 
4. In the list box, highlight the child record(s) that you want to reorder. 
 

5. Use the up button  and the down button  to move the child record(s) up 
and down as needed. 

 
6. When you are finished, click the Apply button to save your changes.  
 

The child records now appear in the order that you specified (Figure 4-3). 
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Figure 4-3. View Bibliographic Record Window 

 
In Figure 4-3, notice that the second element of the 004 tag indicates that the child is 
no longer number 6, but number 4. 
 

4.2 Expanding/Collapsing/Printing a 

Tree 

 
Three right-click options on the View Bibliographic Record window let you expand, 
collapse, and print an archival tree.  
 
To expand all the records in a tree, you can click the + sign next to every branch, or 
you can use the Expand All option. Conversely, to collapse all the records in a tree, 
you can click the - sign next to every branch, or you can use the Collapse All option. 
To print a copy of a tree, use the Print Tree option. 
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To expand all the records in a tree, 
 
1. Right click anywhere on the View Bibliographic Record window. 

 
2. Choose Expand All from the pop-up menu. 
 

The tree expands all its branches (Figure 4-4). 
 
 

 

Figure 4-4. View Bibliographic Record Window - Tree Expanded 

 

Hint: With a tree expanded, you may want to enlarge your viewing area. To do 
this, place your mouse cursor on the border between the archival tree and the tabs 
below the tree. When the cursor turns into a double arrow, drag the tabbed portion 
of the window downward.  

 
To collapse all the records in a tree, 
 
1. Right-click anywhere on the View Bibliographic Record window. 
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2. Choose Collapse All from the pop-up menu. 

 
The tree collapses all its branches so that only the Fonds level is displayed (Figure 
4-5). 

 
 

 

Figure 4-5. View Bibliographic Record Window - Tree Collapsed 

 
To print a copy of a tree, 
 
1. Right-click anywhere on the View Bibliographic Record window. 

 
2. Choose Print Tree from the pop-up menu. The Print dialog box appears (Figure 

4-6).  
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Figure 4-6. Print Tree Options 

 
3. Choose a range: 
 

 All - Prints information for all of the records in the record tree. If the tree is 
very large, this may take a long time. 

 Selected Records - Prints information for only those record(s) you have 
highlighted. To highlight multiple records, hold down the CTRL key as you 
select records in the tree, or hold down the SHIFT key to select a range of 
records. 

 Selected with Child Records - Prints information for the currently selected 
record(s) and all child records, including children of the child records. 

 
4. Choose the number of copies, and click OK. 
 

Hint: To print a copy of a single record, display the desired record in the View 
Bibliographic Record window. Right click and choose Print. In the Print dialog box, 
select Full or MARC in the Format drop-down list. 

 

4.3 Relinking Records in a Tree 

 
You can relink a child record to a different parent in an archival tree. To do this, you 
must open in the MARC Editor the child record that you want to relink and manually 
edit the 004 tag to include the Bib ID of the parent record to which you want to relink 
it. 
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When you save the record to the database, Virtua will automatically regenerate the 999 
ANCESTRY tag to reflect the change. 
 

4.4 Keeping Track of Relationships: 

About the 999 ANCESTRY Tag 

 
The 999 ANCESTRY tag is a system-generated tag in a linked MARC record that 
stores information about the record’s relationships and level in an archival tree. You 
cannot edit the data in this tag. 
 
The subfield $a of the 999 ANCESTRY tag contains the value ANCESTRY. The 
second subfield is $k, the third is $l, the fourth is $m, etc. Each subfield represents a 
level in the hierarchy, with subfield $k representing the highest level, or Fonds. Thus 
the ANCESTRY tag in any given linked MARC record will contain specific subfields, 
depending on the level of the record in relation to the root bibliographic record in the 
tree. In this way, the ANCESTRY tag of a record that is at the lowest level of an eight-
level hierarchy would contain the following subfields: 
 
$k Fonds 
$l Sub-fonds 
$m Sub-sub-fonds 
$n Sub-sub-sub-fonds 
$o Series 
$p Sub-series 
$q File 
$r Item 
 
The value in each subfield is a Bib-ID prefixed by a capital letter, starting with the 
letter A, which is incremented in each subsequent subfield. For example, subfield $k 
contains the Bib-ID of the root bibliographic record (i.e., Fonds) prefixed with the 
letter A. Subfield $l contains the Bib-ID of the next level record (i.e., Sub-fonds) 
prefixed with the letter B. Subfields $m through $z contain the Bib-IDs from other 
related records in the archival tree. If the tree contains more records than can be 
contained in subfields $l through $z, then subfields $A through $Z are used.  
 
If a gap exists between a child record and its parent, the Bib-ID of the parent record, 
prefixed with an X, will be placed in the subfield appropriate to the gap level. If 
another gap exists at the next level, this same parent Bib-ID, again prefixed with an X, 
will be placed in the subsequent subfield.   
 
The example below illustrates the aspects of the ANCESTRY tag we just discussed. 
Note that subfields $l - $n show that the parent record (whose Bib-ID is contained in 



Archives Management (v. 16.1)  39 
 

PROPRIETARY INFORMATION OF INNOVATIVE INTERFACES, INC.  

subfield $l) has a child record (whose Bib-ID is contained in subfield $o) separated by 
two gap levels (whose Bib-IDs are contained in subfields $m and $n). 
 

999 \a ANCESTRY \k A0004648 \l B0005109 \m X0005109 \n X0005109 \o 
E0004766 \p X0004766 \q G0033075. 
 

Some of the hierarchical information stored in the ANCESTRY tag is also reflected in 
two other tags in an archival record—the 351 tag and 004 tag. 
 
For example, in Figure 4-7, the ANCESTRY tag contains five subfields, indicating that 
this record is five levels down from the root record. Subfield $n contains an X, 
indicating a gap between the parent and this child record. If the library uses eight 
archival levels in its structure, this ANCESTRY tag would indicate that this record is at 
the Series level. This is confirmed in tag 351 subfield $c, where the library has 
cataloged the record level as Series. 
 

 

 

Figure 4-7. The 999 ANCESTRY Tag 
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In addition, the linking 004 tag contains information about the hierarchical level of this 
record (Figure 4-8). 
 
 

 

Figure 4-8. The 004 Linking Tag and Position Numbers 

 
In the 004 tag,  
 

 The number 2 at the end of the parent Bib ID indicates that this record is two 
positions away from its parent, which is India official correspondence 1752-1774. 

 

 The number 1 that comes after the 2 at the end of the parent Bib-ID indicates that 
one gap exists between the parent and the child. 
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5. Appendix A - Important Tags in 

Archival Record Management 

 
This appendix summarizes three important tags used in archival functionality. The tags 
are the 001, 004 and 999 ANCESTRY. 
 

5.1 001 Tag 

 
The 001 tag stores the system-assigned number known as the Bib-ID. Virtua 
automatically assigns a Bib-ID to every bibliographic record that is created. Using the 
Bib-ID in a control number search is the most direct way to access a bibliographic 
record in the database.  
 

5.2 004 Tag 

 
The 004 tag serves several functions in archival functionality. Every archival record at 
every level except the Fonds level contains a 004 tag, which is primarily a linking tag. It 
stores the Bib-ID from the 001 tag of the current record’s parent. In addition to being 
a linking tag, the 004 tag shows the position of the record in relation to its parent and 
siblings. 
 
The 004 tag offers this information via three data elements:  
 
First element - The system number, or Bib-ID, of the parent record. 
 
Second element - The position of the record in relation to any siblings. In this way, a 
1 indicates the first child of a parent, 2 the second child, etc. The second element 
ignores the hierarchical level of the record. For example, the first child of a Fonds 
could be a Sub-fonds, the second child could also be a Sub-fonds, while the third child 
could be a Series or File. 
 
Third element - The hierarchical level of the record. It shows the number of unused 
levels (or gaps) that exist between a parent level and child level.  

 If a description record is attached to a parent record on the level immediately 
above it (e.g., if a Sub-fonds is immediately below a Fonds), a third element will 
not exist in the 004.  
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 If the description record is attached to a parent record that is NOT on the level 
immediately above it (e.g., a File is attached to a Series, where a Sub-series level is 
interposed but unused), a third element will exist in the 004. 

 
Virtua should calculate the third element automatically. But if the tree is very complex, 
Virtua might get confused and fail to calculate the third element. In that case, you will 
need to calculate the third element yourself based on the number of levels in your tree 
structure. The example below uses an eight-level structure: 
 
1: -  Fonds 
2:  -  Sub-fonds 
3:    -  Sub-sub fonds 
4:     -  Sub-sub-sub fonds 
5:       -  Series 
6:          -  Sub-series 
7:            -  File 
8:              -  Item 
 
For example: 
 
Where a Sub-fonds parent has a File child, four unused levels would lie between them 
(Sub-sub fonds, Sub-sub-sub fonds, Series, and Sub-series). In this case, the third 
element in the 004 must be 4. 
 

5.3 999 ANCESTRY Tag 

 
The 999 ANCESTRY tag (so-called because the subfield $a of the 999 tag contains the 
word ANCESTRY) records the hierarchical linkages in the archival records. Virtua 
creates this tag automatically when any archival record below the Fonds level is 
created. You cannot edit information in this tag. 
 
As shown below, letters are used to denote archival levels A-H in subfields $k-$r. 
Missing levels are designated by an X placed in front of the duplicated Bib-ID of the 
parent. 
 
k=fonds (A) 
l=sub-fonds (B) 
m=sub-subfonds (C) 
n=sub-sub-sub fonds (D) 
o=series (E) 
p=subseries (F) 
q=file (G) 
r=item (H) 
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6. Appendix B - Changes in this 

Guide 

 

6.1 Changes for Version 16.1 

 
No changes were made. 
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